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Teaching schedule

Seme
ster Date Lectures Exercises
week
1 122 - 162 Basic information about the subject, content of the subject. MS Word 1
MS Word
2. 19.2. - 23.2. MS PowerPoint MS Word 2
3. 26.2. - 13. MS Excel MS Excel 1
4. 4.3. - 8.3. MS Access MS Excel 2
5. 11.3. - 15.3. Big Data MS Excel 3
6. 18.3. - 22.3. Information Systems TEST 1: Word + Excel
7. 25.3. - 29.3. MS Project MS Power Point
8. 1.4. - 5.4, Free - Easter holidays MS Access 1
9. 8.4. - 12.4. Creation of web pages MS Access 2
10. 15.4. - 19.4. Programming MS Access 3
11. 22.4. - 26.4. Artificial intelligence MS Access 4
12. 29.4. - 3.5, Cyber security TEST 2: Access
13. 6.5. - 10.5. Credit week Credits




Conditions for passing the subject

Credit
= 1. test - MS Word + MS Excel = 35 points
« 2.test - MS Access = 23 points
= 60 points
At least 38 points required!
Exam

- Theory test on the topics of Big Data, Information systems, MS Project, Web
page creation, Programming, Artificial intelligence, Cyber security.

= 40 points



Information about the subject

«LMS Moodle -
https://moodle.uniag.sk/course/view.ph

p?1d=358

Contact: marcela.hallova@uniag.sk


https://moodle.uniag.sk/course/view.php?id=358
https://moodle.uniag.sk/course/view.php?id=358

Text editing applications

= Google Docs a

= Notion @
= Evernote Q = RemNote *

= Microsoft OneNote m = Mylnfo n

= Notepad++

- LaTeX TEX




MS WORD Eu

A word processor that is part of the MS Office office
suite.

First version for 0S Windows - 1989 - 14 versions in
total so far.

Creation and formatting of documents.

Track document changes, collaborate and share
documents.



Basic terms m

Document is the name for a file created in MS Word.

Since it Is a substitute for handwriting, we call the
individual pages of the text with the word page.

Continuous text is divided into paragraphs - any
continuous text from the beginning until the moment
we press ENTER.

After that, we only divide the paragraphs into
sentences and words.



Text highlighting

CTRL + SHIFT+ arrows - choosing words in different
directions.

Ctrl + Shift + End - highlight the entire text from the
cursor to the end of the document.

Ctrl + Shift + Home - highlight the entire text from the
cursor to the beginning of the document.

Ctrl + A - highlight all text in all parts of the document.
double click - highlight the whole word.
triple click - highlight the entire paragraph.



Fonts and formatting m

Serif fonts - vertical ends of letter strokes that
visually help keep the line flat, Times New Roman.

Sans-serif fonts - graphically simpler, Arial, Tahoma,
Verdana...

Written, decorative and special fonts - written and
calligraphic scripts, as well as archaic and futuristic,
missing character sets for Central European
languages (accented letters).



Combining fonts m

The rule i1s that there should be a
maximum of two types of fonts in one
document.

Multiple FONTS in one text make the
text more digficult te read and visually
discourage Bhe redder.




Page numbering and section breaks

-',E% Breaks v | Indent Spacing

Page Breaks

- Page numbering from the first page.

Page

_

. Mark the point at which one page ends
- Page numbering from the second page. and the next page begins.

Column

Different First Page

Indicate that the text following the column
break will begin in the next column.

(] Different Odd & Even Pages

Text Wrapping

0= Separate text around objects on web
Show Document Text pages, such as caption text from body text.
Options Section Breaks

Next Page

(it

Insert a section break and start the new

. . / section on the next page.
- Numbering from a certain page - e

Continuous

Insert a section break and start the new
section on the same page.

section breaks.

Even Page

1 [l

|V
FY
1

Insert a section break and start the new
section on the next even-numbered page.




Numbering from a certain page

Let's say we would like to number the document from the 6t page, how to do that :

1)

2)

3)

4)

5)

We need to set the cursor to the end of the 5t page. Always to the end of the
previous page from which we want to set the numbering.

Then, on the Layout tab in the Page Set-up group, use the tool Breaks ->
Section Breaks - Next Page.

In this way, we divided the document into 2 sections. The first 5 pages that will
not be numbered and the rest that will be numbered.

/\ But that's not alll You still need to disconnect the footers or headers from
each other, or both at the same time, depending on where you want to put the
numbering.

It is necessary to set the cursor somewhere in the footer/header of the next
section. In other words, you can always separate the next footer/header from
the previous one. We created 2 sections, so it is necessary to be at the foot of
the 2"d section to disconnect it from the 15t section.

After disconnecting the header or footer, you can insert page numbering.



W

Formatting tags

= The Show All button on the Home tab in the Paragraph group turns hidden characters
on and off. g : ‘

Paragraph Y

- They help in formatting texts or identifying breaks in the document. Settings - File -

Options -D |splay Always show these formatting marks on the screen
[ ] Tab characters —
|:| Spaces
("] Paragraph marks q
(] Hidden text abe
(] Optional hyphens —
Object anchors J}

[] Show all formatting marks



Table of Contents creation

Normal ‘ No Spacing Headmg 1 Heading 2

1) Setting styles in the document.

T|t | e Subtitle Subtle Emphasis Emphasis

2) References - Table of Contents

) Add Text v at; [} Insert Endnote }
H ~
Table of D| Update Table Insert a3 Next Footnote Se: .
Contents v Footnote D Table of Contents : =
( . . Index Tableof;ontents Table of Figures  Table of Authorities
Print Preview Web Preview
Automatic Table 1 HEAdING 1 veevrvvrrerressvererseern 1y Heading 1 I
Contents Heading 2..vcvvvncsresveiisis 3 Heading 2
Heading 1 ! i Heading 3
Heading 2 1 Heading 3....cccvviviniceeniininnns 5 Heading 5
, ing 3 1
g & show page numbers B use hyperlinks instead of page numbers
3) E d I t I n g . # ’ Right align page numbers
Tab leader: .. v
General
Formats: From template ~

-

4) Update table. e

Options... Modify...



List of figures, tables and equations

1)

2)

First, it is necessary to enter a caption

Insert

of the objects. Captior

After entering the caption, it is possible to
create a list.

The created list can be updated even after insertion.

Insert Table gf Li#flires
k

Insert
Caption |_—E| Cross-reference

Captions

Insert Table of Figures

Cross-reference

able of Figures

Index Table of Contents Table of Eigures

Print Preview

Table of Authorities

Web Preview

Figure 1: Text....ocovvieveeeeiiniciinienens 1
Figure 2: TeX covvvvvererererererererereinns 3
Figure 3: TeXt .o 5
Figure 4: Text....coovvevveeeiiniiiinienens 7

Figure 1: Text
Figure 2: Text
Figure 3: Text
Figure 4: Text

ﬂ Show page numbers
a Right align page numbers

Tab leader: ..

General
Formats: From template A
Caption label: | Figure ~

s Include label and number

ﬂ Use hyperlinks instead of page numbers

Options... Modify...



Cross references W

= Using a cross-reference, we can create a link with other parts of the same document.

@ Link ~

1) Inthe document, we enter the text, image, etc., with which the cross-reference should [] Bookmark

[ Cross-reference
Links

begin.

2) Onthe Insert tab, click Cross Reference.
3) Inthe Reference type field, click the drop-down list and select the object you want to link

t 0. Cross-reference O X
Reference type: Insert reference to:
Numbered item ~ | |Paragraph number ~
s Insert as link D Include above/below

Separate numbers with

For which numbered item:

4) In the Insert reference to box, click the information you want to insert into the document.

5) In the For which field, click the specific item you want to link to, for example, to insert a
cross-reference.

6) To allow users to jump to the linked item, select the Insert as a link check box.

7)  If the Include above or below box is available, check it to include the relative position
specification of the referenced item and click Insert.



Citations and Bibliography W

- Every thought and text that did not come out of your head is the
work of someone. The method of citation is regulated by the
norm [S0 690 -

https://www.slpk.uniag.sk/sk/citovanie_odkazovanie/

= Forms of citation:

- APA - style of the American Psychological Association, is used mainly In
the field of education, social sciences, psychology and technology.

= Chicago - form of citation in science.

- |[EEE - technical and scientific papers should be cited in I[EEE or Institute
of Electrical and Electronics Engineers style modeled after the Chicago
Citation Style.

- Harvard - way of referencing within the norm IS0 690.


https://www.slpk.uniag.sk/sk/citovanie_odkazovanie/

Citations and Bibliography - method

1) Place the cursor at the end of the text you want to cite. [ U Feram

Insert

. . . . Citation ¥ [T Bibliography v
2) References - Citations and Bibliography Citions & Bibliography
) ] = E Manage Sources |]
3) Choose a citation style. > syl WA
Citation v [T] Biblio| APA

4) Click Insert Citation. Ciations & silid Sixth Edition

S50 617 1| MLA
Seventh Ed_ition

5) Select Add New Source and fill in the source information.

6) | nsert a B | b |.| O g I"a p hy DJ} Bibliography v | Caption |._E| Cross-reference
{ Built-In
Bibliography
Bibliography
Haas, ). (2005). Creating o Formal Publication. Boston: Proseware, Inc.
Chen, J. (2003). Citations and References. New York: Contoso Press.
Kramer, 1. D. (2006). How to Write Bibliographies. Chicago: Adventure Works Press.




Mailings W

= Solving tasks where we need to create documents whose
content is the same, but each document also contains unique
values.

- |t Is possible to draw data for mailings from: a Word
document, an Excel workbook, an Outlook address book and
an Access database.

- Letters, envelopes, labels and emails can be created.

B B B OB B B B

R | [l
Envelopes Labels = Start Mail Select =

Merge ¥ Recipients v

Create Start Mail Merge Write & Insert Fields Preview Results Finish



Procedure for mailings

- 1. STEP: In the first step, we select one of the options: Letters, E-mail messages,
Envelopes, Labels or Directory.

= 2. STEP: In step two, it is necessary to select the document that we wish to use: 1.
Current document, 2. Template, 3. Existing document.

= 3. STEP: In the third step, you need to select the list of recipients, in most cases it will
be Excel or Access, so you need to click on the button. Search and find a database with
a list of recipients on your computer.

« 4. STEP: In step four, certain elements are selected from the list of recipients, such as:
Name, Surname, Address..., which are inserted into the text, and then in step five, Word
changes them to specific values from the database.

= 9. STEP: In the fifth step, it is possible to view all recipients, or to additionally exclude
them from the list.

= 6. STEP: In step number six, the given documents are either printed or, in the case of
e-mails, sent via Outlook.



Additional tools in Word

= Quick Parts - creating and inserting ~ ocument Property .
frequently used phrases or blocks of text, = Field..
such as directions to an address or an ™ [ zuiing focks Orgaiser..

_} ¥ ‘ @ v TT Equation  ~

#a AutoText

answer to a frequently asked question. -
Allows you to speed up repetitive tasks in
documents. B S B B-
- Tracking changes in documents - — = ihwwmgkpp | e ?
recording changes in the document. Tracking S changes
- Document protection - protect the Tz
document against unwanted changes. m /E’
- Voice dictation of text and text reading. & N O [“
Dictate Read ( -
v Aloud Restrict
Editing




Creating forms in Word

- Word allows you to create a form for filling in answers from other
users.

= First, it Is important to activate the Developer tab.

E_ﬁ__ﬂ_: E‘r ERecord Macro CQ {g} IE__IE{:} Aa Aa S| NDE‘S@“ Mode E ;_j I:bé] H

Visual Macros @l Add- Word COM D XML Mapping Restrict  Document
Basic A\ Macro Security ins  Add-ins Add-ins 5 Eg - = Pane Editing Template
Code Add-ins Controls Mapping Protect Templates
= Use of Controls for filling out the form. # Click or tap to enter a date. |
<] februar 2024 [>
™= EE 1 - ) po ut st 5 pi so ne
Aa Aa o= M Design Mode (] L Choose an item.

w 29 20 3101 2 3 4

— T |=|1 5 6 7 8 9 1011
v aas” D 12 13 14 15 16 17 18

19 20 21 22 23 24 25
.—|.

m— E“v | = 26 27 2829 1 2 2

= g — _

C o~ =T o o oAaAn

Controls



rirovircauliing uic tcat aliu saviily uic

document

- Be sure to check before publishing the file or sending it somewhere else

Spelling and Grammar!

itff Spelling and Grammar ~ |

Spelling

v Spelling and Grammar

-« The document can be saved in different formats,
the basic format is docx.

Word Document (*.docx)

Word Document (*.docx)

Word Macro-enabled Document (*.docm)
Word 97-2003 Document (*.doc)

Word Template (*.dotx)

Word Macro-enabled Template (*.dotm)
Word 97-2003 Template (*.dot)

PDF (*.pdf)

XPS Document (*.xps)

Single File Web Page (*.mht, *.mhtml)
Web Page (*.htm, *.html)

Web Page, Filtered (*.htm, *.html)

Rich Text Format (*.rtf)

Plain Text (*.txt)

Word XML Document (*.xml)

Word 2003 XML Document (*.xml)
Strict Open XML Document (*.docx)
OpenDocument Text (*.odt)



Special type - random text generator

- Word includes built-in random text generators that easily create text of the required
length and structure (paragraphs, sentences). Do not look for the meaning in the text,
that is not its purpose, it is mainly the possibility to verify the formatting setting before

we start our own writing, or as in this case - to simply have a longer text available for
any kind of testing.

It must be created on a new linel!
- The first generator is a text generator in the English language in the form:

=rand(1,2) - the first argument is the number of paragraphs,
the second the number of sentences.

- The second generator is a Lorem ipsum pseudo-latin text generator in the form :

=lorem(1,2) - the first argument is the number of paragraphs,
the second the number of sentences.
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